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Overview 

What is a Purchase Order (PO)? 

An on-line form completed in the Oracle Financials System and then issued by a Carnegie Mellon 

University (CMU) buyer to a supplier indicating types, quantities, and agreed prices for products or 

services the supplier will provide to Carnegie Mellon. Sending a PO to a supplier constitutes a legal 

offer to buy products or services. Acceptance of a PO by a supplier usually forms an agreement 

between the buyer and seller. 

Purchasing Process Flow 

 
In this training manual, the focus will be on creating purchase orders and receiving against the 

purchase orders. 

If you recall from Oracle 101, data entry forms can include Headers and Lines and some forms like 

the Purchase Order also contain distributions.  In this course, you will enter three variations of 

Purchase Orders as shown here. 

  PO Exercise #1   PO Exercise #2   PO Exercise #3 

  PO HEADER   PO HEADER   PO HEADER 

  PO Line 1   PO Line 1   PO Line 1 

  >>Shipment 1   >>Shipment 1   >>Shipment 1 

  >>>>Distribution 1   >>>>Distribution 1   >>>>Distribution 1 

  
 

       

  PO Line 2   PO Line 2     

  >>Shipment 1   >>Shipment 1     

  >>>>Distribution 1   >>>>Distribution 1     

           

   PO Line 3   

      >>Shipment 1     

      >>>>Distribution 1     

      

   PO Line 4   

   >>Shipment 1   

   >>>>Distribution 1   

We’ll begin with PO Exercise #1.  This is a simple purchase order containing two PO Lines with one 

shipment and one distribution for each PO Line. 
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Entering a Purchase Order, Exercise #1 

The Vice President of your division has selected a new table and chairs for the main conference 

room.  The furniture will be purchased from one of our existing Oracle suppliers, Tri-State Office 

Furniture.   

 

The conference table itself is $6,000 which is over the $5,000 threshold for capital furniture here at 

CMU.  The chairs, however, are $110 each.  You are purchasing 15 chairs.  When deciding if the 

furniture is capital or non-capital, each piece is typically considered individually.  Thus, the chairs are 

non-capital furniture as they are well below the capital threshold.  

 

We will have to enter two separate lines on this PO, one for capital furniture and one for non-capital 

furniture, because different object codes will be used in the Distributions (account strings charged). 

 

Note:  The cumulative value of this purchase above the micro-purchase threshold.  Remember, any 

purchase more than $5,000 must be made via purchase order. 

 

To start, be sure to select the Oracle responsibility that is the appropriate ledger for the purchase 

order you wish to enter.   

 

For today’s training session, we will be working in the USA Ledger.   

 

1. At the Oracle home page expand the responsibility USA POREQ Buyer and Approver, then expand 

the Purchase Orders folder, and click on the Purchase Orders link. 
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2. From the Home Page the system opens a blank Purchase Orders form for data entry. 

 

 

Purchase Order (PO) Header 

 

3. Data entry begins in the PO header section.  The header section contains general information about 

the purchase order, such as the Supplier, the Buyer and so on.  The header also contains the 

Description field that buyers use to enter the business justification. 

 

 
 

a. The Operating Unit will default with the appropriate 

value for the ledger you are working in.  Although this field is yellow, it is protected from 

update.  The  field and the 

 fields are gray.  This means they are protected from 



 6 

update by the system and you cannot enter data into these fields.  The Created field is 

systematically populated with the data and time (EST) the purchase order was started.  The 

PO number is populated by the system when the PO is saved.  The Rev (Revision) number is 

incremented by the system each time a PO is altered after initial approval. 

 

b. The system automatically defaults to the first yellow field called Type.  

  Always accept the default value of “Standard PO”. 

c. Press the Tab key on your keyboard.  This moves your cursor to the 

 field.  Click on the List of Values icon.  The supplier 

must be in the university’s Oracle supplier database in order to be selected. If a new supplier 

is needed, they can be added by filling out the Invite New Vendor Questionnaire in 

PaymentWorks. 

 

 
 

d. The List of Values is not empty.  Imagine all the suppliers Carnegie Mellon (CMU) has 

used over the years.  Let’s narrow down the list.  In the Find

 
field, enter “TRI-STATE%”. 

1. Note: In Oracle, “%” is a wildcard.  Entering “TRI-STATE%” will only bring 

back any results starting with “TRI-STATE.”  Likewise, entering “%TRI-

STATE%” will bring back any results containing “TRI-STATE.” 

 

 

https://paymentworks.com/login/saml/?idp=carnegiemellon
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e. Click on the  button. 

 

f. A reduced List of Values displays. 

 

 
 

g. Select “TRI-STATE OFFICE FURNITURE INC”. 
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4. The Supplier is populated and the system moves to the next field.  It is the  

 field. Some companies may have different warehouses/plants 

from which they ship their product.  These are referred to as “sites”. 

 

5. Remember what a white field indicates?  Though this Site field is “optional” for Oracle, it is required 

for CMU business purposes.  If the Supplier you selected has only one Site, the system will 

automatically populate the field.  If the supplier has multiple sites, the List of Values icon will display 

in the field.  Click on the List of Values. 

 

6. The list is reduced to the Sites applicable to the Supplier we selected, namely, Tri-State Office 

Furniture Inc.  You will become familiar with the sites for a particular supplier as you work with the 

supplier.  For this example, this supplier has two Sites, choose – Pittsburgh PA. 

 

7. The  field is optional for Oracle and for CMU business policy.   

Click on the List of Values.  When you do you should see the message 

 at the very bottom left of the screen.  Contacts may or may 

not be entered at the time of supplier setup.  We’ll leave it blank.  Press the Tab key on your 

keyboard. 

 

8. The  field is also required by CMU business policy even though it 

is white.  Ship-To “locations” have been setup for different campus areas. We want the new furniture 

delivered to the UTDC Building on Henry Street. Let’s use a shortcut to find the location.  In the Ship-

To field, type in the letters ‘UTDC’ and press the Tab key on your keyboard.   

 
 

9. A reduced list of values shows with just the ship-to locations starting with “UTDC”.  Notice that 

entering “UTDC” and pressing Tab entered the wildcard at the end of the word.  These are 

abbreviated addresses, but the full ship-to address will print on the PO. Select UTDC, Ste 414.  Note: 

There are two special Ship-Tos; None and Notes. 
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10. The  field defaults to Accounts Payable.  For the majority of purchase 

orders this does not change.  The Accounts Payable address prints on the PO so the supplier knows 

where to send the invoice.  Press the Tab key on your keyboard. 

 

11. The  field either defaults to the functional currency of the ledger (USA – USD) or 

to the payment currency a supplier has requested.  If the supplier has requested a special payment 

currency, it is entered with the supplier information on setup.  The field is protected and you cannot 

type a change directly into the field.  However, you can change the payment currency as follows: 

 

a. Click on the  button at the bottom of the form.  The Currency form 

displays. 

 
 

b. Click on the List of Values in the currency field.  
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c. You can only select from the currencies enabled in the Oracle system.  Select GBP – Pound 

Sterling. 

 

d. The Rate Type is “Corporate”.  Select this value either from the List of Values or by using the 

shortcut method for the field.  The Rate Date must either be the current date or a date in the 

past.  No rates will have been assigned yet for future dates. 

 

                               
 

e. The system automatically populates the rate.  Note:  In class it is necessary to back the 

Rate Date up a day because the Oracle instance being used is populated with the previous 

day’s data and rates. 

 

                            
 

f. Now the rate field is populated.  Let’s change the currency back to USD. 

 

12. The  defaults to your name.  The name should change only if a 

different buyer makes changes to the PO and sends it for approval. 

 

Note: If a buyer leaves the university or moves on to another position, there needs to be a reassignment of 

duties to manage that buyer's purchase orders. 

 

13. The  field is gray.  It will default with the appropriate value once 

the purchase order is sent for approval. 
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14. The  field will be systematically populated as you add lines to the 

purchase order. 

 

15. The  field is 

optional.  This description is for your internal use only and does not print on the purchase order.  

This is where you indicate the business justification for this purchase.  As a general rule, business 

justifications for any purchase should answer our 5 Ws (who, what, when, where, why) and how the 

purchase relates to university business. Type ‘NEW FURNITURE FOR MAIN CONFERENCE ROOM IN 

STE 414.’ into the description field. 

16. The last field on the Header to be entered is the small field  to the right of the Total.  Click in 

the field.  A decision box opens. 

 
 

a. The first field, Bid Checklist Required, is used to indicate whether the purchase order 

requires a Purchasing Checklist and Bid Summary form to be completed.  In the 

Introduction to Purchasing training class, you were taught the criteria to determine 

whether a checklist is required.  Remember that you can use the Buyer’s Action Matrix 

to determine the documentation requirements for your purchase.  For training 

purposes, let’s assume the answer is ‘YES’. 

1. A completed Purchasing Checklist and Bid Summary Form is required for 

purchases $5,001 USD or greater made with a non-preferred supplier. All 

purchases of $150,000 USD or greater, regardless of the source of funds or type 

of supplier utilized, are required to complete this form per the university 

Procurement Manual 

b. The second field, PMWeb Commitment Id, is not used by the majority of campus.  This 

is only for any departments that utilize PMWeb.  We will not enter anything in this field. 

 

17. At this point, you can save the purchase order.  The system will generate a purchase order number 

in the PO field. 

 

18. Save your work.  Write down the purchase order number → 
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Purchase Order Attachments 

 

Attaching the required Purchasing Checklist and Bid Summary Form (Bid Checklist) to purchase 

orders in Oracle eliminates the need for a separate submission to Procurement Services, allows 

approvers to view the attachment in their workflow notification to ensure the necessary steps have 

been completed prior to the purchase, and helps alleviate potential audit concerns with missing Bid 

Checklists. 

 

1. While in any field in the PO header section, click the Attachments paper clip icon in the toolbar.   

 

 
 

a. Note:  The PO must be saved before an attachment can be added.  If the PO has not 

yet been saved, a decision box will open and ask if you want to commit (save) the 

record.  Click Yes. 

 
2. The Attachments form will open.  This is where the Bid Checklist can be uploaded as an attachment 

on the PO. 

 

  



 13 

 
 

a. Note:  Documents must be attached at the header level.  Otherwise, approvers are 

not able to see the attachment.  Make sure that the Entity Name is PO Header. 

3. Click on the Category field.  To see the available Category values click the List of Values button  

and enter the % wildcard.  Select the Bid Checklist option. 

 

 
 

a. Note:  The Miscellaneous option can be used for any other type of supporting 

documentation, such as any necessary gift processing forms, quotes, etc.  

b. The Title and Description fields are both optional.  The title is what the approver(s) 

will see in the workflow notifications as the link to the attachment.  If a title is not 

entered, the file name or URL will show as the document name.  The description 

could be used to provide a brief description of the attachment.    

 

4. In the Title field, enter “TRI-STATE CHECKLIST” 
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5. Click on the Source tab.  A Decision Box will pop up asking if the file has been uploaded successfully.  

Do not click on either Yes or No yet. 

 
a. The Bid Checklist category defaults to a Data Type of File and automatically opens a 

browser window/tab to allow you to browse for and submit an attachment.    

b. Note: this window often opens behind the Oracle application.  Locate the internet 

browser window titled GFM Upload Page.  

 
 

6. On the GFM Upload Page, click the Browse button to search for the file to submit (upload).    

 

 
Note: If you are not able to locate your desired file, follow the steps below for practice purposes. 

If you are able to find your file, skip to number seven below the dotted box to continue. 

 

o Navigate to the desired location for the file to be saved (desktop, documents, etc.) 

o Right click in the window and hover on New, then click New Microsoft Word Document 
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o Rename the file and press enter 

• Note: The system won’t let a blank file be uploaded 

o Right click your new document and click edit 

 
o Add some text in the document and save the file and close Word 

o Continue with step seven below 

Note: This is only to be done for training purposes only. You should never upload blank or test 

documents for your attachments 

 

 

7. Select the file from your computer to upload and click Submit.  

 
 

 

8. After receiving confirmation the file was successfully uploaded, click the Close Window link.  
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9. This will take you back to the Oracle Attachments form with the Decision box asking if the file has 

uploaded successfully.  Click Yes.  

 

   
 

10. The file name will appear in the File or URL field.    

 

 
 

11. Close the Attachments window by clicking on the X in the upper right corner of the form.  This will 

take you back to the Purchase Order screen.  

 

12. To confirm that the Bid Checklist attachment was successfully added, click any field in the PO header 

and confirm that the paperclip icon now has a piece of paper in it.  

 
 

We are finished with the Header section of the PO.  Let’s move on to the lines. 
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Purchase Order (PO) Lines 

 

 
 

The Lines contain the detail information about what is being purchased. This section also contains 

“tabbed regions”.  Each tab holds different information applicable to the PO.  However, the Lines tab 

is the only one that contains required fields.  

PO Line 1 

1. Click into the Num field on the first line. 

 

 
 

2. The system automatically numbers each line as they are entered.  Notice now some of the fields 

have turned to yellow.  Click into the Type field then click on the List of Values icon. 

 

 
 

3. There are four choices for PO Line Type.  Each type determines what will be entered into the 

Quantity and Unit Price Field and what the default will be for the Unit of Measure (UOM) field. 

(Remember, you can use the Edit icon on the Oracle toolbar to view the total contents of a field.) 

 

a. GOODS – AMOUNT – Ordering goods based on a total dollar amount.  For example, 

buying $5,000 worth of office supplies from Office Depot over a 3 month period.  Also 

useful when ‘splitting’ a purchase between multiple accounts strings by varying amounts 

(e.g. 18/35/47 or 63/73).  For example, splitting the cost of a piece of equipment shared 

by multiple departments.   

 

UOM Quantity Unit Price Total 

Currency used above 5000 $1 $5,000 
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b. GOODS – QUANTITY (default line type) – Buying goods based on specific quantity.  For 

example, 5 cases of paper from Office Depot.  If a lesser quantity is received, buyer can 

easily receive to ensure only quantity received is paid for.   

 

UOM Quantity Unit Price Total 

Each 5 $20 $100 

 

c. SERVICES – AMOUNT – Ordering service based on a total dollar amount.  Best used for 

recurring invoices (draw down POs) where multiple invoices are expected in varying 

amounts.  For example, contracting computer maintenance for $100,000 billed 

throughout the year.  Also useful in cases where only one invoice is expected but the 

amount needs to be ‘split’ between multiple account strings. 

UOM Quantity Unit Price Total 

Currency used above 100000 $1 $100,000 

 

d. SERVICES – QUANTITY – Ordering service based on a defined quantity, UOM and Price 

such as Rate/Hour.  For example, Xerox repairman @ $20/Hr. for 3 hours.  Also useful 

when multiple invoices are expected that will be identical each month.  For example 

computer maintenance costing $60,000/yr. that will be billed at $5,000 each month for 

12 months.  This would allow the buyer to receive a quantity of (1) each month. 

 

UOM Quantity Unit Price Total 

*Each 3 $20 $60 

                            *For the example above, the UOM can be changed to Hour. 

 

4. The purchase order is for one conference table.  Select GOODS – QUANTITY because we are buying 

goods (table) based on a specific quantity (one). 

 

5. The Item and Rev fields  are not used at CMU. 

 

6. Click or Tab into the  field. The category is a general description of the goods or 

services being purchased.  You should select the category that bests fits the purchase. The category 

for this PO line is FURNITURE & FURNISHINGS.  Use a shortcut or the List of Values to select this 

category. This field is case sensitive, so use uppercase if you choose the shortcut. 

 

7. Notice that the Description  field is yellow which means it is required.  Enter 

the description as follows:  “14FT RACETRACK VENEER CONFERENCE TABLE WITH HALF DRUM 

BASE IN A LIGHT CHERRY FINISH”.  This description tells the supplier what product or service you 

want.  Give as much information to the supplier as you can so the supplier knows exactly what you 

want.  If you have a model number or supplier catalog number, include it here. 
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8. The Unit of Measure (UOM)  field defaulted to EACH because the Line Type selected is 

GOODS – QUANTITY. 

9. Enter a quantity of one into the Quantity  field. 

 

10. Type 6000 into the Price  field.  Do not enter a dollar sign ($) or commas.  In addition, 

the price must be in the currency selected at the header level.  If we had selected the Pound Sterling, 

the price entered would have to be in pound sterling.   

11. If you scroll to the right you will see the  fields.  These are optional.  If 

you were negotiating with the supplier and were given a “Promised” delivery date you could enter it 

into the Promised field.  If you needed the laptop by a specific date you could enter it into the Need-

By field. 

 

12. The remaining fields in this tab are not used by Carnegie Mellon. 

 
 

For this example, we have completed the header and a line of the purchase order.  Essentially, we 

have selected the supplier (header) and selected “what” we want to purchase, namely, the New 

Furniture for main conference room in Ste 414.   

 

Let’s move on to Shipments. 

Shipments (PO Line 1) 

 

Shipments tell the supplier where the product should be shipped.   

 

1. Click on the  button at the bottom of the form to open the Shipments form. 
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2. The Shipment Num  field is systematically populated sequentially starting with the number ‘1’. 

 

3. The Org  field is gray indicating that it is protected by the system and cannot be changed. 

 

4. The Ship-To  field defaults from the Ship-To on the PO Header.  The Ship-To can be 

changed; however, this is a simple purchase order with only one shipment.   

 

5. The UOM  field defaults from the Lines section of the PO and cannot be changed. 

 

6. The  field defaults from the Lines section of the PO and can be changed.  Do not 

change it for this example. 

7. The optional Promised Date and Need-by dates  default from the 

PO Lines section but can be modified here. Leave these blank for this example. 

 

That completes the Shipments data for this PO.  There is one more piece of information that we 

need to enter on this PO, which is the Distribution(s).   
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Distributions (PO Line 1) 

 

Distributions indicate “who” will be charged for this purchase.    You will enter the General Ledger 

(GL) or Grants Management (GM) account that will be charged for the purchase in the Distributions 

form.   

 

Click on the  button. 

 

 
 

1. When the Distributions form opens, you will be on the Destination tab. The  tab is 

used to enter a GL account string.  Notice there is also a  tab.  We will use the Project 

tab later in the class to enter a Grants account string. 

 

2.  The  field and the  field are systematically populated and should not be 

changed. 

 

3. The Requester field  is optional.  Let’s enter Walker, Kylie for this exercise.  When 

the requestor is entered, the ‘Deliver-To’ field will automatically be populated with their campus 

address in the system, but can be changed if needed. 

 

4. The Quantity field  value comes from the quantity entered in the Shipments form.   



 22 

5. Scroll to the right to reveal the  field.  This field is used to enter 

a GL account string.  Click into the field. 

 
 

6. Doesn’t this look familiar?  It is the Accounting Flexfield but it is called the “Charge Account” in the PO 

module.  Using the skills you learned in Oracle 101, enter the following account string: 

87200.000001.520.000.570010.01 

 

 
 

Note:  The object code 87200, Capital Furniture was selected because the purchase amount is 

$6,000 which is over the capital threshold of $5,000. 

 

7. Click on the  button. 
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8. Scroll all the way to the right to see one more required field in the Destinations tab. 

 

9. The GL Date defaults to the current date.  This date must always be within an open period. Do not 

change the date for this exercise. 

 

 

 
 

 

10. This completes the Distributions. Close the Distributions and Shipments forms by clicking on the X 

at the upper right corner of each form. 

 

11.  Save your work. 

 

PO Line 2 

 

1. Let’s complete Line 2 of this PO, place your cursor into the next available line in the Lines section of 

the Purchase Order. 

 
 

2. System automatically sequences the line numbers. Type defaults to GOODS – QUANTITY. Accept the 

default.  We are selecting this type because we are purchasing goods (chairs) and a specific quantity 

(15). 

3.  The category is FURNITURE & FURNISHINGS.  Remember this field is case sensitive. 

4. In the Description field  type ‘MESH BACK TASK CHAIR WITH MID-BACK IN 

BLACK MESH’.  Remember, you can use the Edit  icon to help you type this into the field. 
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5. Quantity is 15 and Price is $110 each. 

 
 

Note:  The system keeps a running total in the  field in the 

header area. 

 

Shipments (PO Line 2) 

6. Click on the  button.  The Ship-To defaults from the Header and the Quantity 

defaults from the lines.  

 

 
 

7. Accept the defaults.  The chairs are going to UTDC, Suite 414.  Now complete the Distributions, that 

is, what account will be charged. 

Distributions (PO Line 2) 

8. Click on the  button. 
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9. The next distribution will be to a Project, Task, and Award (PTA). Click on the  tab. 

 

 
 

 

10. The Project tab opens with the first row number highlighted in yellow and the cursor in the project 

field. Type 47242 into this field and press the Tab key on your keyboard. 

 
 

11. Once a Project is entered, other required fields turn yellow. Type Task number 1 into the 

 field. Press the Tab Key on your keyboard. 

 

12. Type the Award number 5007162 into the   field. Press the Tab key on your 

keyboard. 

 

13. Next is the   field. Type is the Expenditure Type in Grants. Select NON-CAPITAL 

FURNITURE for the Type. 

 

Note: If you recall from Chart of Accounts, the Expenditure Type in Grants is typically same as the 

name of the Object Code in GL, The object code we used for the GL account string is 86200. The 

name of this object code is NON-CAPITAL FURNITURE. 

 

14. Select INSTITUTIONAL RESEARCH AND ANALYSIS for the . In Grants, the name of 

the organization is used, not the value. 

 

15. The last required field is the . Click on the list of values calendar to select the 

current date. 

 

16. Save your work. 
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17. Return to the Destination tab. Scroll to the right to view the PO Charge Account. 

 
 

18. The system automatically generates the equivalent GL account string for the PTA. But, notice that 

the field is gray which means it is protected and you cannot make changes. Any changes must be 

made to the PTA. 

19. Close the Distributions and Shipments forms by click on the  at the top right hand corner. 

 

Summary  

You have finished entering data for Purchase Order Exercise #1.  You selected Tri-State Office 

Furniture as the supplier in the header.   

 

PO Line 1 contained the conference table (what) which was to be shipped to UTDC, Suite 414 

(where) and charged to the Institutional Research (who) GL account string with a Capital Furniture 

(87200) object code. 

 

PO Line 2 was for the 15 chairs (what) to accompany the table.  They were also to be shipped to 

UTDC Suite 414 (where) and charged to the Institutional Research (who) PTA account string with a 

Non-Capital Furniture type category. 

 

 

  PO Exercise #1   PO Exercise #1 

  PO HEADER   Tri-State Office Furniture 

  PO Line 1   Conference Table 

  >>Shipment 1   >>UTDC, Ste 414 

  >>>>Distribution 1   >>>>87200.000001.520.000.570010.01 

  PO Line 2   Chairs 

  >>Shipment 1   >>UTDC, Ste 414 

  >>>>Distribution 1   >>>>28408.1.5004620 
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PO Workflow and Approval 

There is an approval process in Oracle associated with purchase orders.  All purchase orders must 

be approved before they can be sent to a supplier. 

 

Purchase Orders (PO) enter a workflow when submitted for approval in Oracle.  The workflow 

evaluates the information entered on the PO and determines if the PO goes to your supervisor 

and/or to one of the special approval checkpoints.  

 

In supervisory approval, the system will direct the PO to the submitters’ Oracle supervisor for 

approval when necessary.  If that supervisor does not have sufficient rights to approve, the systems 

will follow the submitters’ supervisor hierarchy until it finds an approver with appropriate rights to 

approve the PO.  

 

Each workflow checkpoint has designated approvers who can approve the PO.  Some checkpoints 

are “final approvals” meaning the PO does not also have to go through supervisory approval.  If a 

workflow checkpoint does not have final approval, the PO may then also require supervisory 

approval if it is above the amount the buyer has the rights to approve.       

 

Note:  See the Appendix for more information regarding the Purchasing Workflow. 

 

To submit a PO for approval: 

 

1. Click on the  button.   
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2. The Approve Document opens. 

 

 

 

3. CMU utilizes encumbrance accounting. 

 

 

 

 

4. Check the box next to Reserve in the Encumbrance region . 

5. The system automatically checks the Submit for Approval selection in the Approval region.  

 . 

6. The Forward  function allows you to forward the PO to another person.  Click on the 

checkbox next to forward.  The Forward From and the Forward To fields systematically populate. 

A PO creates an obligation to pay referred to as an encumbrance.  These entries 

are sent to both the General Ledger (GL) and Grants Management (GM).  An 

encumbrance is simply money set aside for planned purchases.  Reports can be 

run in the system showing money you have spent and money you are planning to 

spend (encumbrances). 
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7. The Forward From field cannot be changed.  The Forward To field is populated with your Oracle 

supervisor, but can be changed.  Perhaps you are filling in for another buyer who is on vacation.  You 

may want to forward the PO to that buyer’s supervisor.   

8. Uncheck the Forward function; we are not forwarding this PO.  

9. Transmission Methods are not used at CMU.  We will talk about how to get the PO to the supplier later 

in the class. 

 

 

10.  Click on  button to submit the PO for approval. 

 

11. The following Decision box will appear. 

 

 

12. Click on the  button.   

 

13. This Purchase Order will stop at the Procurement Services Checkpoint.  The instructor will approve all 

purchase orders in the PS Checkpoint before class moves forward.  Any purchase order that requires 

a Purchasing Checklist and Bid Summary form will also route through the Procurement Services 

checkpoint prior to moving through the supervisory approval or any additional checkpoints.   
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14. Once the purchase order has been approved, you will see that it is in Approved, Reserved status. 
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Purchase Order Inquiry 

When a purchase order (PO) is “in process” of being approved, you cannot open the PO, but you can 

check on the PO by using the Purchase Order Inquiry function. 

 

1. From the module Navigator menu, select Purchase Order Summary under the Purchase Orders 

menu branch 

  

 

2. The Find Purchase Orders form opens. 

 

 

3. As you learned in Oracle 101, you can type criteria in one or a number of the fields in a Data Inquiry 

form.  You can even enter criteria in the different “tabbed regions”.  For example, you can select a 

range of dates for purchase orders in the tab “Date Ranges” as shown below. 



 32 

 

 

4. For this search, however, we will just use the PO number for Tri-State Furniture that you just sent 

for approval.  Enter your PO number from into the Number field.   

 

 

5. Notice under Results you can select from various sections of the PO.  Accept the default “Headers” 

and click on the  button.  The Purchase Order Headers form displays. 
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6. As you can see the Open button is grayed out .  Move the scrollbar to the right 

until you see .  As mentioned earlier, you cannot open a PO with an Approval 

Status of “In Process”.  However, you can check to see where the PO is in that process. 

7. Under Inquire on the Oracle menu, select View Action History. 

 

 

8. The form that opens lists the steps the PO has gone through so far. 

 

a. Seq 1 – Checking of the Reserve box on the Approval Document. 

b. Seq 2 – Clicking on the  button to submit the PO for approval. 

c. Seq 3 – Forward means the PO has been forwarded to the workflow which channels it to 

the appropriate approvers. 

d. Seq 4 – Has “No action taken” in the Action field.  This indicates that the PO is waiting in 

the Procurement Services queue for approval. Once someone with access to the 

checkpoint approves the PO, that name will appear in the Performed By field and the PO 

will move to the supervisory approval hierarchy. 

9. Close the form by clicking on the X at the top right corner.   

10. Back at the Purchase Order Headers, you can click on the  button to view the 

lines entered on this PO. 
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11. From Lines we can move on to .  Shipments only display for the line selected 

above. 

 

12. Then click on the  button.  Distributions display only for the shipment selected. 

 

 

13.  Press F4 on your keyboard to return to the module Navigator menu. 
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Notifications 

▪ The PO submitter receives a notification in their Oracle Worklist and an automated email to your 

andrew email account, when one of the following actions is taken by the PO approver: 

o PO is Approved 

o More information is requested 

o PO is Rejected 

PO is Approved 

Once the purchase order has been approved, the system will send a notification to your Oracle 

Home page and to your Andrew email. 

 

 

• From the Oracle Home page notification, double click on the notification title to open the 

notification. 
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• You will also receive an e-mail that looks like the following: 

 

Oracle Workflow Notification (FYI) 

_______________________________________________________________________ 

Standard Purchase Order 401605 has been approved. 

 

Standard Purchase Order 401605  Amount: USD 126,800.00; 

Tax: USD 0.00. 

Description: NEW SOFTWARE FOR PROCUREMENT SERVICES AND BUSINESS SYSTEMS AND SERVICES 

TEAMS 

 

Preparer: TAYLOR, MARY 

 

Note:  

Purchase Order Lines 

 

Line: 1 

Item Number:  

Rev.:  

Item Description: SOFTWARE IMPLEMENTATION PLUS USER GUIDES 

UOM: HOUR 

Quantity: 1000 

Unit Price: 125.00 

Line Amount: 125,000.00 

 

Line: 2 

Item Number:  

Rev.:  

Item Description: MAINTENANCE AGREEMENT 

UOM: CURRENCY USED ABOVE 

Quantity: 1800 

Unit Price: 1.00 

Line Amount: 1,800.00 

 

Approval Sequence 

 

Sequence: 5 

Who: PERKINS, AMANDA K 

Action: Approve 

Date: 03-JUL-2018 

Note:  

 

Sequence: 4 

Who: MALTA, JAMIE M. 

Action: Approve 

Date: 03-JUL-2018 

Note: 
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Sequence: 3 

Who: TAYLOR, MARY 

Action: Forward 

Date: 03-JUL-2018 

Note:  

 

Sequence: 2 

Who: TAYLOR, MARY 

Action: Submit 

Date: 03-JUL-2018 

 

Sequence: 1 

Who: TAYLOR, MARY 

Action: Reserve 

Date: 03-JUL-2018 

Note:  

 

More Information is Requested 

 

 
 

• Double-click on the subject to open the notification. 

 

• At the very bottom is a Response area where you can answer the question. You may answer the 

request yourself, or you may transfer the request for more information to another user.  If you 

choose to answer the question yourself, type in your response and then click on the  

button to send it back to the approver. 
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PO is Rejected 

 
 

It is important that you take action on a PO that is rejected or contains a request for more 

information.  Do not leave the PO in a rejected state.   

 

For example, you may call your approver and verbally answer the request for more information; 

however, the PO will not be approved until you send it back to the approver. 

 

If the PO is rejected, contact the approver to find out why?  If the approver wants something 

changed you can modify the PO as we will do later in this course.  Don’t create a new purchase 

order.  If the approver doesn’t want the PO at all, then delete the PO.   
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Printing Purchase Orders  

Once a purchase order is approved, the next step would be to forward it to the supplier.  This will 

require printing the purchase order report.  The report creates a PDF, which will enable you to save 

your PO and send it electronically to the supplier or print and mail it to the supplier. 

1. Navigate to Reports>Run 

 

 

2. Submit a New Request form opens.  

 

 

3. The system defaults to a single request.  Click on the  button.  The Submit 

Request form opens. 
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4. Click into the yellow name field to select a report.  The report you want is “Printed Purchase Order 

Report (Portrait) Approved Only”.  Again this is a reminder that only approved purchase orders 

can be printed.  Once the report is selected a Parameters form will appear specific to this report. 

 

 

5. Populate the following parameters: 

a. Print Selection:  Select the value “All” 

b. Purchase Order Numbers From/To:  Enter your purchase order number(s) in the From and 

To fields.  You can do a range of Purchase Orders or a single one.  

i.  If printing a single purchase order, be sure to put the number in both the To and From 

fields.  If you enter a number in the ‘From’ field, the ‘To’ field will automatically populate with 

the same number. 

ii. If selecting a range of purchase order numbers, be sure to enter your name in the Buyer 

field so only your purchase orders print. 

6. Click on the  button. 
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7. Click on the Upon Completion…  button. 

 

 

8. You can have the system send an e-mail to another CMU employee that the PO has printed with a 

link to view it.  Simply select an employee name in the Name field under the Notify the following 

people: region.  
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9.  A copy of such an e-mail is shown below: 

 

 

10. You can send a copy directly to a registered printer designated in the Print the Output to: region.  

You can select the printer and the number of copies you want to print. 

 

 

11. When you have completed the output options, click on the  button. 
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12. Back at the Submit Request form, click on the  button.  A Decision box will 

show with a Request ID number and the opportunity to run another request. 

 

 

13. Click on the  button. 

 

Viewing Your Printed PO 

1. On the Oracle menu under View, select Requests. 

 

 

2. The Find Requests form opens. 

 

3. Click on ‘Specific Requests’ and type the Request ID into the Request ID field (or leave ‘All My 

Requests’ marked).   

Write down your Request ID # 
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4. Click on the  button.  The request form opens with the Request ID you entered. 

 

 

5. Click the  button.  The PO opens as a PDF file. 
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6. Opening as a PDF allows you to print or save the purchase order.  Then you can either fax or e-mail 

the PO to your supplier. 
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Entering Receipts 

The system automatically defaults all purchase orders to a three-way match.  This means when an 

invoice is received from the supplier and entered into the system by Accounts Payable (AP), it must 

be matched to a purchase order and a receipt in order for payment to be made.  A receipt 

acknowledges that you have received the goods or services represented by the invoice.  The process 

is depicted below: 

 

Three-Way Match 

 

 

In this “best case” example, a purchase order was created for 10 computers. The invoice included 

charges for 10 computers. Ten computers were received. Once the match is made the payment 

process can begin.   

System alerts are sent to the buyer (creator of PO) when an invoice is entered but can’t be matched 

at 100%. This alert email is the indication to enter the system and create the receipt for the purchase 

order. Failing to enter receipts in a timely manner will hold payment to the supplier. 

Let’s start by entering a receipt for the new furniture from Tri-State Office Furniture on our first 

purchase order. 
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Receiving, Exercise #2 

You have been notified by a staff member that the conference table and 6 of the chairs you ordered 

have arrived.  The other 9 chairs are on back-order and should arrive in a week. You have also 

received the invoice hold email indicating an invoice has been entered in the system.  You decided 

to go ahead and receive against the purchase order. 

1. Navigate to Receiving>Receipts 

  

 

2. An Organizations form opens.  The purchase order was entered into the USA Ledger so highlight 

the CM Inventory Organization. 

 

 

3. Click on the  button.  The Find Expected Receipts form opens. 
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4. Typically, you will be entering receipts for a specific purchase order.  Enter your Purchase Order 

number from Exercise #1 (Tri-State Office Furniture) in the Purchase Order field and click on the 

Find button.   

 

5. The Receipt Header form displays with summary information for the receipt.  You have the option 

to enter additional information in the fields provided in the Header but there are no required fields 

here. 

 

 

6. For now, close the Receipt Header by clicking on the  at the upper right hand corner.   

 

7. The Receipts form now shows with all shipments that meet the search criteria. 
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8. As with other purchasing forms, there are “tabbed regions” containing various data about the 

receipt.   On opening, the form defaults to the lines tab.  Click on the Order Information tab. 

 

 

9. This tab lists the PO #, PO Line and Shipment.  This tab becomes important when the purchase 

order contains multiple lines/shipments/distributions to help ensure you are creating the receipt for 

the appropriate line.   

 

10. On the bottom of the form is information about the purchase such as the PO#, Supplier, Due Date 

and so on. 

 

11. Select the Line you want to create a receipt for by clicking into the tiny white box next to the line. 

. If the box is not checked a receipt will not be created. 

12.  The Quantity  field displays the quantity due for shipment.  However, the quantity can 

be changed as necessary, such as in the case of a partial receipt (e.g. 10 items were ordered, but 
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only 5 received so far).  Once this line is fully received the quantity will be zero.  For this example, we 

will not be changing the quantity. 

 

13. Click on the Lines tab. 

14. The   field is required.  For this receipt enter the following: .  

 

15. The Destination field at the bottom of the form is now populated. 

 

 

16. Click the checkbox next to Line two.  Change the Quantity from 15 to 6.   

17. Add the location. Do you remember how to copy the field above? 

 

 

18. Save your work. 

19. Click on the  button on the bottom of the form. 

 

20. When the header reappears you will see the system has generated a receipt number. 

21. Return to the Navigator menu (F4). 
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Wait for the instructor to continue. 

A week has passed.  The table has been set up in the main conference room.  You discovered that 

there is a large scratch on one of the legs.  You contacted Tri-State Office Furniture and the manager 

offered a $500 discount in lieu of replacing the table.  You accepted it.  Hopefully, people won’t 

spend their time in meetings looking at the table legs.  In addition, the other 9 chairs have arrived. 

You need to modify the purchase order to reflect the new price on the table and you need to receive 

the additional 9 chairs. 

In order to change the price on the PO, we need to undo the receipt which is referred to as a ‘return’ 

in Oracle. In this case, we are not actually physically returning the table. 

Since the table has been matched to an invoice we would need to contact Accounts Payable to 

create a reverse/hold on the payment. 

 

Modifying a Purchase Order 

1. Navigate to Purchase Orders>Purchase Order Summary 

 

 

2. The Find Purchase Orders form opens 

  



 52 

 

3. Enter the Tri-State Office Furniture PO# in the Number field. 

4. Click on Shipments in the Results region. 

 

 

5. Click on the  button.  The Purchase Order Shipments form will open. 

 

 

6. Click on the little yellow folder at the top left. 
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7. Simply click the  button to open the PO STATISTICS folder.  Folders allow you to look at data 

in different formats.  

 

 

8. The two columns we need to verify are Qty Received and Qty Billed for Line 1.  

a.  Qty billed is one so that means an invoice has been processed by Accounts Payable 

(AP).  Since there is an amount billed, it is necessary to contact AP to have them 

temporarily “unbill” the invoice.  Wait for AP to verify this is complete before 

continuing. 

b. Qty Received shows a ‘1’, so we will have to do a return before we can modify the 

price on the conference table.  Again we are not actually returning the table to the 

supplier.  We need to undo the receipt. 

9. Press F4 on your keyboard to return to the Navigator menu. 

Creating a Return 

1. Navigate to Receiving>Returns 

 

 

2. On the Find Returns form enter the Tri-State Office Furniture PO number from in the Purchase 

Order field. 
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3. Click on the Find button. 

4. The Receiving Returns form looks very similar to the Receipts form. 
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5. Click on the Order Information Tab. 

 

 

6. Notice the lines are reversed.  Always click on the Order Information tab to be sure that the action 

you are taking is on the correct line.  Select the second row (Line 1) by clicking on the checkbox next 

to it. 

 

 

7. Enter the quantity you wish to return.  In this case, the quantity is 1 meaning one conference table. 

 

 

8. Click on the Transactions tab.  The Return To field is required.  Click into the field. 
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9. Click on the List of Values. 

 

 

10. Only two choices appear.  Always select Supplier. 

11. Save your work  

12. F4 to return to the Navigator menu.  That completes the return.  Now you must change the price on 

the Purchase Order. 

Changing an Approved PO 

1. Navigate to Purchase Orders>Purchase Order Summary 
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2. The Find Purchase Orders form opens 

 

3. Enter the Tri State Office Furniture PO # in the Number field. 

4. Click on the Find button. 

5. When the Purchase Order Headers form displays click on the Open button. 
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6. When the purchase order opens click into the first line. 

 

 

7. Some of the fields turn yellow but the price field is grayed out.  You cannot change the price until 

you unreserve the funds.  Be sure that you cursor is on the line that you want to modify. 

a. Note: Oracle will allow you to change the price without unreserving the funds.  This 

will lead to issues with the encumbered amount on the PO.  ALWAYS unreserve the 

line(s) that require modification before moving forward. 

8. On the Oracle menu under Tools, select Unreserve. 

 

 

9. An Unreserve box will display with today’s date. 
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10. Click on the OK button to accept today’s date.  Always use today’s date.  A Decision box will show 

confirming the action. 

 

 

11. Click OK to close the box. 

12. The Status has now changed to . 

 

13. Click into the price field and change the price from 6000 to 5500.  The field is now yellow and can be 

modified.  Click into the second row. 

 

a. Notice when you click into Line 2, the Price is grayed out.  When you Unreserve as 

shown here you are unreserving funds for just the one selected line.  If you needed 

to change the price on Line 2, you would begin with Step 8 again.  

14. Go to the Distributions form and verify the GL Date is a date in the current period. 

GL Date 

All transactions, including encumbrances, end up in the General Ledger.  The GL date on the 

distributions must coincide with the open period in the General Ledger.  At the beginning of each 

period, the Business Systems and Services Team opens the period to allow transactions into the 

General Ledger.  At the end of the period, Business Systems and Services Team closes the period 

after month-end processes are complete and no more transactions can be entered into the GL.  A 

period is equivalent to one calendar month. 

 

When entering a new PO, this GL Date is automatically populated with the current date and is 

typically not changed.  When modifying the PO, the GL Date is not changed systematically.  You must 

manually change the date if the modification is being done in a different period. 

 

For example, if you created and approved a PO on Jul 14, 2016, the GL Date would show .  

Perhaps something occurred that required modification to the PO on Aug 12, 2016.  When you 

modify and unreserve a line, the GL Date will still be Jul 14, 2016 on the Distributions form.  You 

must change the GL Date to a date in the current period or you will get the following Error message.                 
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15. Save your work.  The following Note box will appear. 

 

 

16. Click OK to close.  The system will populate a revision # in the Rev field. 

 

 

17. Submit PO for approval.  The following message will immediately appear. 

 

 

18. Because we lowered the price of the table from $6,000 to $5,500, approval is simply a formality and will 

automatically be done. 

19. Click on .  The Status has now changed to  

 

20. Go into Receipts and create a new receipt for the conference table. 
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21. Create a Receipt for the additional 9 chairs.  The quantity to receive for the chairs will be only nine 

because you had already received six prior to this. 

 

 

22. Save and F4 to return to the Navigator menu. 



 62 

Copy a Purchase Order 

 

 

1. Open the Purchase Order branch of the Navigator menu and select Purchase Order Summary. 

 
 

2. The Find Purchase Orders form will display. 

  
 

3. This is an Oracle Inquiry form.  We know that because there is a  button. 

4. In the  field enter the Purchase Order number the instructor gave 

you. 
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5. Click on the  button. 

 

6. The Purchase Order Headers form will open. 

 

 
 

7. Click on the Tools menu and select Copy Document. 

 
 

8. On the Copy Document form, click on the  button.  Leave Copy Attachments 

selected. 
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9. A note will appear announcing that a new Purchase Order has been created. 

 

 
 

10. Write down the new Purchase Order number.                             

11. Click on the  button. 

 

12. The new Purchase Order is opened. 
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PO Header: 

 

 
 

1. The Header has been completed.   

a. Supplier: Solution Beacon LLC 

 

b. Site:  Seattle 

 

c. Contact:  Alicia Hoekstra 

 

d. Ship-To:  US UTDC FLOOR 2 Note: The current naming convention for campus locations is 

Country (US) Building (UTDC) Floor or Office (FLOOR 2). 

 

e. Buyer:  Change the Buyer name to your name. 

 

f. Description:  New project management software for Procurement Services and Business 

Systems and Services Team plus a maintenance agreement. 

 

g. Bid Checklist Required:  ‘Yes’. 

 

h. The Purchasing Checklist and Bud Summary form has also been attached and will copy with 

the purchase orders.  Notice that the paperclip icon has a piece of paper in it. 

 

1. Click into the Buyer field.   Notice the instructors name is listed 

because that is who created the PO you copied. 

 

2. You should select your name by opening the List of Values.   

 

 
 

3. Or by typing in the first few letters of your last name. 

 
 

4.  Then press the Tab key on your keyboard.  The name will automatically populate or you will get a 

reduced list of values from which to make a selection. 

 
 

Note: If a buyer leaves the university or moves on to another position, there needs to be a reassignment of 

duties to manage that buyer's POs. 
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5. Now view the attached documentation on this purchase order.  In this case, a Purchasing Checklist 

and Bid Summary form has already been attached.  To view the attached documentation, click on 

the paperclip icon while the cursor is anywhere in the PO header. 

 

 
 

6. With the cursor in the appropriate line (shown by blue indicator), click Open Document.  The 

following decision box will appear, typically on the Internet Explorer window titled Oracle 

Applications R12: 
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7. Click Open.  The Checklist will open in Microsoft Excel. 

 

 
 

8. Attach additional documentation to this purchase order.  To view or make changes to existing 

attachments, click on the paperclip icon while the cursor is anywhere in the PO header.  To add 

another attachment, click into the second line in the Attachments screen.   

 

 
 

9. In the category, select Miscellaneous.  Type M and Tab.  Oracle with auto-fill the Miscellaneous 

category since it is the only option in the list that starts with M. 

 

10. Enter “Software Package Quotes” in the Title field. 
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11. Click on the Source tab.  Notice that you do not automatically get the Decision Box like we did 

before.  This time, we must indicate which Data Type we are using. 

 
 

a. The preferred Data Type at CMU is File.  The other Data Types available are:  

i. Long Text / Short Text - The Long Text option allows for up to 32,000 characters 

in the text box.  The Short Text option allows you to enter up to 4,000 

characters in the text box. The only reason you should use either of these fields 

is if you need to provide backup that contains sensitive information (social 

security numbers, salary data, etc.) or that your business manager deems 

confidential to the department and you don’t want to attach the document to 

the purchase order in Oracle.  Use this data type to reference the location of the 

file on the shared drive. It is important to make sure your approver(s) have 

access to the location you reference in order to review the backup.  

ii. Web Page - You would use this option if the information that you want to 

include as documentation is located on a webpage. Choosing this option allows 

you to add a URL in the file or URL field.   

1. Note: When working in Oracle within the Citrix (virtualized) environment, 

approvers will not be able to click on a URL in their notification and get to a 

web page.  Access to the web is restricted in Citrix.  

 

12. Select a Data Type of File and follow the steps on pages 14-16 to attach the additional file. 
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Purchase Order Practice Exercise #3 

Use the PO number that you created during the ‘Copy Purchase Order’ exercise to complete this 

practice exercise.  If you do not have your ‘Copy Purchase Order’ number, you can search for it using 

the Purchase Order Summary function OR you could just begin a new purchase order for this 

exercise. 

 

Carnegie Mellon has decided to purchase a new software package.  Bids were taken and the firm 

Solution Beacon was chosen to do the implementation.  Their estimate is 1,000 hours at $125/hr.  In 

addition, CMU will be purchasing a maintenance agreement from Solution Beacon for $1,800 per 

year.  The cost of the implementation will be shared between Procurement Services and the 

Business Systems and Services Team because the software will be installed in both locations.  Even 

though Procurement Services negotiated the maintenance agreement, the cost will be split between 

the two departments and will be paid monthly.  Solution Beacon will also create a user guide for 

each department. 

 

 

PO Header 

1. The Header information should be as follows (may have already been completed during the 

‘Copy Purchase Order’ exercise).   

a. Supplier: Solution Beacon LLC 

 

b. Site:  Seattle 

 

c. Contact:  Alicia Hoekstra 

 

d. Ship-To:  US UTDC FLOOR 2 Note: The current naming convention for campus locations is 

Country (US) Building (UTDC) Floor or Office (FLOOR 2). 

 

e. Buyer:  Make sure your name is showing. 

 

f. Description:  New project management software for Procurement Services and Business 

Systems and Services Team plus a maintenance agreement. 

 

g. Bid Checklist Required:  ‘Yes’. 

 

h. Purchasing Source: BID 

 

i. Attach documentation as necessary following steps on Page 14 – 16. 

 

Purchase Order (PO) Lines 

 

PO Line 1  

 

1. The first line will contain the software implementation service provided by Solution Beacon.  This is 

based on the number of hours it will take to complete the implementation. 
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2. Type: SERVICES QUANTITY.   This type is selected because we are ordering a 

service based on a defined quantity (500), UOM (hours) and price ($125/Hr.). 

 

3. Category:  Professional Services. 

 

4. Description:  Software implementation plus user guides. 

 

5. UOM:  Changed to Hour.  Solution Beacon estimates the implementation will take 1,000 hours. 

 

6. Quantity:  500 (hours). (will be 1000 in total) 

a. Since two departments are sharing the cost of the 1000 hours, change 

the quantity to 500 here. We will add a second line for the remaining 500 

hours later. 

 

7. Price:  $125 per hour. 

 
 

 

As part of the 1,000 hours of implementation, Solution Beacon will be creating software user guides. 

A user guide will be shipped to both departments, which are in different locations.  Therefore, you 

need to do two PO lines, both with different shipments. 

 

 

Shipments (PO Line 1) 

1. Click on the  button.  The Shipments form opens. 

 

 
 

2. The Ship-To here is defaulted from the header.   This is the location for 

Procurement Services.   
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3. Procurement Services is responsible for half of the purchase. This first Line, Shipment, and 

Distribution are addressed to that department.  

 

Distributions (PO Line 1) 

 

1. Let’s add the Distribution for this shipment.  Click on the  button. 

2. For this particular PO, let’s enter an employee in the Requester  field.  Select 

Jonathan Mosimann (from Procurement Services) as the requester. 

 

3. The Deliver-To field is automatically populated.    However, the 

list of values icon indicate that the Deliver-To can be changed.   

 

4. Enter the following GL account string in the PO Charge Account field:  

85313.000001.520.000.540500.01.  This is Procurement Services account string. 

 

5. Scroll to the right to verify that the GL Date field  contains the current date. 

 

6. Save your work. 

7. Go back to the Lines form by clicking on the  at the top right corner of the Distributions and 

Shipments forms. 

 

PO Line 2  

Since we need to split the order, we need to create a second Line with new information in the 

shipment and distribution 

 

1. Click into the next blank Line row. 

 

2. Click the Edit menu at the top left. Hover on the word Duplicate, then click Record Above. 

 This will make a copy of the first line. 

 

Shipments (PO Line 2) 

 

1. Click the Shipments button. 

 

2. The Ship-to for the second line has to be changed to Financial Systems (the former name of the 

Business Systems and Services Team.)  Click into the Ship-To on the second row.  The List of 

Values icon appears.  Click on it. 



 72 

 
 

3. Do you remember what it means when a List of Values appears to be blank?  Let’s narrow down 

the search.  We know the Business Systems and Services Team is in the UTDC Building.  In the 

 field, type %UTDC%.  We put the % sign on both sides of the building 

name to make sure we see the old and the new naming convention. 

 

4. Click on the  button.  A list of locations for the UTDC building displays. 

 

 
 

5. Select the one that has FINANCIAL SYSTEMS in the description. 

  
 

Distributions (PO Line 2) 

 

1. Click on the  button. 

 

2. Enter the Requester here as Derek Sommer.   

3. If needed, change the Deliver-To field to US UTDC FLOOR 5  

 

4. Enter the following GL account string:  85313.000001.520.000.540900.01. This is the Finance 

Training and Communications account string. 
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5. Scroll to the right to verify that the  field contains the current date. 

  

6.  Close the Distributions and Shipments forms to return to the Purchase Orders form. 

 

7.   Save your work. 

 

 

PO Line 3 

 

1. Line 3 was not yet started on the purchase order we copied, so we need to create the line.  This line 

will cover the maintenance contract. 

 

2. Type: Change the field to SERVICES - AMOUNT.    This type is selected because we are ordering a 

service (maintenance) based on a dollar amount ($900).  Although the total maintenance contract is 

$1,800, it will be paid in monthly increments instead of the full amount at one time. It will also be 

split between two departments. 

 

With GOODS – AMOUNT or SERVICES – AMOUNT you can create a line that can be used like a Draw-

Down PO.  The dollar amount becomes the quantity and the Unit price is 1.  As you receive the 

goods or services, you can incrementally draw-down or decrease the balance on the PO.  This allows 

you to create one line for the entire amount such as the $1,800 instead of twelve lines for $150 each. 

The $150 will be received each month against this one particular line reducing the remaining 

balance each month.  These types are excellent for things like leases.  They also work well if you 

have a budget of $5,000 over period of time with the same supplier for say office supplies or if you 

are entering a purchase order based on a quote for a service but won’t know the final amount until 

the service is performed or goods are delivered. 

 

3. Category:  Professional Services. 

 

4. Description:  Maintenance agreement. 

 

5. UOM:   Defaults to CURRENCY USED ABOVE because of the line type selected.  Accept the default. 

 

6. Quantity:  900.  This is half of the total amount of the maintenance agreement. 

 

7.  Price:  Price automatically defaults to ‘1’ when you select SERVICES -AMOUNT as the Type. 

 

Wait for the instructor to continue. 

 

Now the third and fourth PO lines need Shipments and Distributions.  Let’s make this interesting.  

Each Line and Shipment will be the same but the two distributions will be different.  One distribution 

will go to a GL account string and one will go to a Grants account string. 

 

Shipments (PO Line 3) 
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1. While on Line 3, click on the  button at the bottom of the form.  The Shipments 

form displays. 

 
 

2. The Ship-To defaults from the header and the Quantity defaults from the PO line.  This is for a 

maintenance agreement so there is no real shipment.  Just accept the defaults.   

 

Distributions (PO Line 3) 

 

1. Click on the  button.  The Distributions form displays.  Remember that 

in this exercise two departments (Procurement Services and Business Systems and Services 

Team) are splitting the cost of the maintenance agreement to two different account strings.  We 

are creating two different Lines in order to split our Distributions. 

 

 

2. Let’s enter Jonathan Mosimann as the Requester for this distribution.  The Deliver-To auto-fills 

with his campus location.  

 

 
 

3. Scroll to the right to see the PO Charge Account field.  Enter the following GL account string.  

. 

 

4. Scroll to the right to verify the GL date.  It should be a date within the current open period. 

 

5. Save close distributions and Shipments.  

 

PO Line 4 

 

1. From the PO Lines area, start a new line. 

 

2. Duplicate the Line 3 by clicking Edit -> Duplicate -> Record Above. 

 

Shipments (PO Line 4) 

 

3. Click the Shipment button. 
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4. Accept the defaults, and click the Distribution button. 

 

5. Enter Derek Sommer as the Requester for the second distribution.  The Deliver-To auto-fills 

with his location but can be updated as needed.  Do you remember how to update the Deliver-

To field?  

 

 
 

Distributions (PO Line 4) 

 

1. The next distribution (for the Business Systems and Services Team) will be to a Project, Task and 

Award (PTA). Click on the Project  tab. 

 

 
 

2. The Project tab opens with the second row number highlighted in yellow and the cursor in the 

Project field. Type 45284 into this field and press the Tab key on your keyboard. 

 
 

3. Once a Project is entered, other required fields turn yellow.  Type Task number 1 into the 

 field.  Press the Tab key on your keyboard. 

4. Type the Award number 1012623 into the  field. Press the Tab key on your 

keyboard. 

 

5. Next is the  field.  Type is the Expenditure Type in Grants. Select PROFESSIONAL 

SERVICES for the Type. 

 

Note:  If you recall from Chart of Accounts, the Expenditure Type in Grants is typically same as the 

name of the Object Code in GL.  The object code we used for the GL account string is 85313. The 

name of this object code is PROFESSIONAL SERVICES.   
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6. Select FINANCE TRAINING AND COMMUNICATIONS for the .  In Grants, the 

name of the organization is used, not the value. 

7. The last required field is the .  Click on the list of values calendar to select the 

current date. 

 

8. Save your work. 

 

9. Return to the Destination tab.  Scroll to the right to view the PO Charge Account. 

 

 
 

10. The system automatically generates the equivalent GL account string for the PTA.  But, notice 

that the field is gray which means it is protected and you cannot make changes.  Any changes 

must be made to the PTA.  

 

11.  Close the Shipments and Distributions forms. 

 

12. Submit the PO for approval.  (Refer to pages 35 - 37 for help.) 

 

13. Return to the Navigator menu, F4. 

 

Summary  

You have finished entering data for Purchase Order Exercise #3. 

 

In the header, the supplier selected is Solution Beacon.  The first line is for the software 

implementation (what) which included shipment of manuals to the two departments.  You split 

Shipments between the two departments (where) with each shipment having its own distribution 

account string (who). 

 

The second line was for the maintenance agreement (what).  There is no physical shipment involved 

so you accepted the default shipment information (where).  However, the cost of the maintenance 

agreement was to be split between the two departments (who) so you had to split the distributions. 
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  PO Exercise #3   PO Exercise #3 

  PO HEADER   Solution Beacon LLC 

  PO Line 1   New Software Package, Implementation 

  >>Shipment 1   >>US UTDC FL2, Manual 

  >>>>Distribution 1   >>>>85313.000001.520.000.540500.01 

    

 PO Line 2  New Software Package, Implementation 

  >>Shipment 1   >>US UTDC FL5, Manual 

  >>>>Distribution 1   >>>>85313.000001.520.000.540900.01 

       

  PO Line 3   Maintenance Agreement 

  >>Shipment 1   >>US UTDC FL2 

  >>>>Distribution 1   >>>>85313.000001.520.000.540500.01 

    

 PO Line 4  Maintenance Agreement 

 >>Shipment 1  >>US UTDC FL5 

  >>>>Distribution 1   >>>>45284.1.1012623 
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Purchase Order Practice Exercise #4 

Learn by doing 

 

Your business manager wants to purchase five new Dell XPS 11 2in1 Ultrabook for the department 

administrators.  The Ultrabook’s should include the 4th Generation Intel Core i5 Processor, Windows 

10, 4GB Memory and 128GB Solid State Drive.  The Dell sales representative quoted you a total price 

of $5,999.95, (1,199.99 ea.).   

 

Create a new purchase order using the skills you have learned in today’s class.  GOOD LUCK! 

 

Navigator>Purchase Order>Purchase Orders 

 

PO Header Information –  

1. PO Type – Standard PO 

2. Supplier – DELL MARKETING LP 

3. Site – ATLANTA 

4. Contact – N/A 

5. Ship-To – UC 103 ADMIN 

6. Bill-To – ACCOUNTS PAYABLE 

7. Buyer – Your Name 

8. Description – DELL ULTRABOOK FOR DEPARTMENT ADMINISTRATORS 

9. PO Headers – Bid Checklist Required? No 

a. Even though this purchase is above the micro-purchase threshold, a Purchasing 

Checklist and Bid Summary Form is not required because Dell is a preferred supplier. 

 

PO Line Information –  

1. Num – 1 

2. Type – GOODS – QUANTITY 

3. Item – not used at CMU 

4. Category – COMPUTER SYSTEMS 

5. Description - Dell XPS 11 2in1 Ultrabook including the 4th Generation Intel Core i5 

Processor, Windows 10, 4GB Memory and 128GB Solid State Drive 

6. UOM – Each 

7. Quantity – 5 

8. Price – $1199.99 
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✓ Screen shot of what your PO should look like 

 

 
 

Shipment Information –  

 

1. Accept the defaults 
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Distribution Information –  

On the Destination Tab – GL Account String 

1. Num – Accept the default – 1 

2. Type – Accept the default – Expense 

3. Requester – Enter your name (last name, first name) (optional) 

4. Deliver-To – will default with your building location or department name, accept the defaults 

5. Quantity – accept the default 

6. PO Charge Account – 86110.000001.520.000.760000.01 

7. GL Date – verify it’s the current date 

 

 
 

✓ Save your work! 

 

✓ Close the Distribution form and the Shipments form 

 

✓ Write down your PO Number                                           

 

✓ Submit your PO for Approval,(refer to pages 27 - 30 for help) 

 

✓ Once your PO is approved, you would follow the steps on pages 39 - 45 to submit the print 

job to print your approved PO and forward to the supplier.  If you would like to practice 

these steps, you may, but not necessary for this exercise.   

 

Now let’s receive on this Dell PO.  Our shipment has arrived along with the invoice.  Dell only 

shipped and billed us for three of the five Ultrabook’s.  Go into the receiving menu and receive three 

Ultrabook’s.   

 

Navigator>Receiving>Receipts 

 

1. Select the Organization – CM Inventory Organization (if needed) 

2. Enter your PO number in the Purchase Order field, click Find 

3. Close the Receipt Header form, it’s not needed 

4. Click the check box on the receipt row, and receive the appropriate number of computers 

5. Verify that the Location field has populated with the requestor information that was entered 

in the Distribution form 
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6. Save your work. 

7. Click on the Header button to verify a receipt was created. 

 
 

Navigator>Purchase Order>Purchase Order Summary 

 

Let’s check the PO Statistics folder 

1. Enter your PO number in the Number field 

2. Change the Results region from Headers to Shipments, then Click on Find 

 

3. Open the yellow folder , select PO Statistics 

 

4. Verify your Qty Due is 2 and your Qty Received is 3 

 

5. Close all forms and return to the Navigator (F4).  
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FCPA Guidance 

The Foreign Corrupt Practices Act (FCPA) 

Remember, the Foreign Corrupt Practices Act prohibits any prohibits any U.S. person or company 

(including the university) from the following: 

• Direct or indirect bribery to a foreign official to obtain or retain and/or direct business to any 

person or to secure an improper advantage 

• Includes any offer, payment, promise of payment, or authorization of payment of any 

money, or offer, gift, promise to give or authorization of the giving of anything of value  

 

Please complete the “U.S. Foreign Corrupt Practices Act – An Overview for Employees of Carnegie 

Mellon University” course available in FocusU.   

 

You may also review the Carnegie Mellon FCPA Guidelines, FAQ’s, and training materials on the 

Office of General Counsel website.  

 

https://focusu.skillport.com/skillportfe/main.action#whatshappening
http://www.cmu.edu/ogc/fcpa/index.html
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Requesting Access to Create Purchase Orders 

 

Access to the purchase order responsibility can be requested using the Core Access Request Form, 

available in the Oracle Provisioning System. 

 

For PO entry access, request the USA POREQ Buyer and Approver responsibility if you are 

purchasing for campuses in the United States.  If you are creating purchase orders for the Australia 

or Qatar campuses, request the needed responsibilities, AUS POREQ Buyer and Approver and/or 

QAR POREQ Buyer and Approver.  The US responsibility cannot be used to make purchases charged 

to Qatar or Australia charge strings and vice versa. 

 

For supplier and payment inquiry, request the AP Inquiry responsibility for the appropriate ledger(s): 

• USA AP Inquiry 

• AUS AP Inquiry 

• QAR AP Inquiry 

 

To request PO approval authority, complete the PO Approval Access Request Form, available in the 

Oracle Provisioning System. 

 

 

 

https://fsg-web.andrew.cmu.edu/prod/srvc/post/main.html
https://fsg-web.andrew.cmu.edu/prod/srvc/post/main.html


 84 

APPENDIX  
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Purchase Order Approval Workflow 

Automated Approval Checkpoints have been added to the approval workflow in addition to the 

standard oracle supervisory approval hierarchy.  
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The following is a description of each workflow checkpoint: 

➢ Bid Check List - As soon as a PO is submitted for approval, the first workflow process will check to 

see if the Bid Check List field is populated. If it is not, the workflow will reject the PO and return it to 

the buyer.  

➢ Entity – The next process will check POs with multiple lines that are charged to more than one 

entity. Some entities cannot be combined on the same PO including: 

o A U.S. (01) entity with International entities (68-80) 

o The SEI entity (05) and with a U.S. (01) entity with International entities (68-80) 

The workflow will reject POs that combine the entities above and return it to the buyer. 

If an invalid entity combination is used, the PO is immediately returned to the buyer with a 

notification that the PO failed the entity check.    

➢ Procurement Services (PS) – This workflow process will check for POs that follow the same criteria 

when the PO requires a bid checklist. If the PO meets these criteria, a notification will be sent to 

users with the WF PO APPRV PS Responsibility. Users with this responsibility can Reject, Approve, 

or Request More Information based on if the purchase meets the requirements of applicable policy 

and if the required documentation has been attached to the PO. If rejected, the PO will be returned 

to the buyer.  If approved, the PO will continue through the rest of the workflow checkpoints and 

Supervisory Approval Groups as needed since PS will no longer be a final checkpoint. Criteria: PO 

totals $5,001 or more and the vendor is not preferred; PO totals $150,000 or more and vendor is 

preferred; PO does not contain an SEI entity (05); and PO does not contain only Subcontracts object 

code (85700).    Approval process:  PS approval is not a Final Approval checkpoint.  The PO will 

continue through the rest of the workflow checkpoints and Supervisory Approval Groups. 

➢ (Qatar Research Office) QRO – This workflow process will check for POs that have a Funding 

Source beginning with 07 or 08 and where the Entity is 68 or 73.  If approved, the PO will continue 

through the rest of the workflow, including the International checkpoint corresponding to the Entity 

associated with the PO.  The QRO checkpoint is not considered a Final Approval checkpoint. 

➢ Benefits - This workflow process will check for POs that have a benefits object code (Including 

domestic and international benefits). Based on the total amount of the PO, a notification will be sent 

to users assigned the Benefits Responsibility. Users with this responsibility can Reject, Approve, 

Reassign, or Request More Information. If rejected, the PO will be returned to the buyer.  If 

approved (and there are no additional lines outside of these Benefits criteria) the PO will not 

continue through the rest of the workflow but instead will be directed to Final Approval unless 

there is an international entity associated with the PO.  The PO will bypass the rest of the workflow 

and the Supervisory Approval Groups. 

➢ Regulatory (Human Subject Payments, Animal Procurement, BioSafety/RDNA) – This workflow 

process will check for POs that have a regulatory object code.  Regardless of the amount of the PO, a 

notification will be sent to users with the Regulatory Responsibility. Users with this responsibility 

can Reject, Approve, Reassign, or Request More Information. If rejected, the PO will be returned to 

the buyer.  If approved the PO will continue through the rest of the workflow and the Supervisory 

Approval Groups. 

➢ Hazardous Materials (HAZMAT) (Chemical, Biological Agent, Radioactive, Human Subject 

Payments, Biosafety/RDNA, Hazmat Chemical) - This workflow process will check for POs that have a 

hazardous materials object code.  Regardless of the amount of the PO, a notification will be sent to 

users with the HAZMAT Responsibility. Users with this responsibility can Reject, Approve, Reassign, 
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or Request More Information. If rejected, the PO will be returned to the buyer.  If approved the PO 

will continue through the rest of the workflow and the Supervisory Approval Groups. 

➢ Software Engineering Institute (SEI) - This workflow process will check for POs that have an SEI 

entity. Based on the total amount of the PO, a notification will be sent to users with an SEI 

Responsibility. Users with this responsibility can Reject, Approve, Reassign, or Request More 

Information. If rejected, the PO will be returned to the buyer. If approved the PO will not continue 

through the rest of the workflow but instead it will be directed to Final Approval. The PO will bypass 

the rest of the workflow and the Supervisory Approval Groups. 

➢ Sponsored Projects Accounting (SPA) - This workflow process will check POs >=5K and < 100K that 

are charged to a federal fund, have an award type of CONTRACT or PRIME FED%, and are not a 

subcontract, consulting service, capital consulting service, or professional consulting service. It will 

also check POs >=100K charged to any PTA whether federal or non-federal.  Based on the total 

amount of the PO, a notification will be sent to users with a SPA Responsibility. Users with this 

responsibility can Reject, Approve, Reassign, or Request More Information. If rejected, the PO will be 

returned to the buyer.  If approved the PO will continue through the rest of the workflow and the 

Supervisory Approval Groups. 

➢ Office of Sponsored Projects (OSP) – This workflow process will check for POs that have a 

Subcontracts object code.  Based on the total amount of the PO, a notification will be sent to users 

with an OSP Responsibility. Users with this responsibility can Reject, Approve, Reassign, or Request 

More Information. If rejected, the PO will be returned to the buyer.  If approved (and there are no 

additional lines outside of these OSP criteria) the PO will not continue through the rest of the 

workflow but instead it will be directed to Final Approval. All international entities will pass to the 

International Checkpoint regardless of whether OSP is a final approval checkpoint.  The PO will 

bypass the rest of the workflow and the Supervisory Approval Groups. 

➢ OSP Consulting - This workflow process will check for POs that have a Consulting Services, Capital 

Consulting Services, or Professional Services object code and are charged to a federal fund.  Based 

on the total amount of the PO, a notification will be sent to users with an OSP Consulting 

Responsibility. Users with this responsibility can Reject, Approve, Reassign, or Request More 

Information. If rejected, the PO will be returned to the buyer.  If approved (and there are no 

additional lines outside of the OSP Consulting criteria) the PO will not continue through the rest of 

the workflow but instead it will be directed to Final Approval unless there is an international entity 

associated with the PO.  All international entities will pass to the International Checkpoint regardless 

of whether OSP Consulting is a final approval checkpoint.  The PO will bypass the rest of the 

workflow and the Supervisory Approval Groups. 

➢ International - –This workflow process will check for POs that have an international entity. Based 

on the total amount of the PO (POs auto-created from requisitions over $50K and any PO created 

without a requisition regardless of dollar amount), a notification will be sent to users with an 

International Responsibility. Users with this responsibility can Reject, Approve, Reassign, or 

Request More Information.  If approved the PO will not continue through the rest of the workflow 

but instead it will be directed to Final Approval. The PO will bypass the Supervisory Approval 

Groups.   

➢ Director Procurement Services – This workflow process will check for POs >$250K and routes to 

the Director of Procurement Services for approval.  If <=$500K the PO will not continue through the 

rest of the workflow but instead it will be directed to Final Approval. The PO will bypass the rest of 

the workflow and the Supervisory Approval Groups.  If >$500K the PO will approve and be 

automatically routed to the Controller checkpoint for final approval. 
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➢ Controller – This workflow process checks for all POs >$500K and routes to the Controller.  If <$2M 

the PO will not continue through the rest of the workflow but instead it will be directed to Final 

Approval.  If >=$2M the PO will approve and be automatically routed to the CFO checkpoint for final 

approval. 

➢ CFO – This workflow process checks for all POs >= $2M and routes to the CFO.  The PO will not 

continue through the rest of the workflow but instead it will be directed to Final Approval. 

➢ Supervisory Approval Groups – After the PO completes all of the workflow checkpoints and if it has 

not already been directed to Final Approval, it will be directed to the Supervisory Approval 

Groups. The process will remain the same. If the submitter has the rights to approve (i.e. the 

amount of the PO is within the dollar limits of the users PO Buyer Group), the PO will approve. If the 

submitter does not have the rights to approve, the PO will automatically be directed to their Oracle 

supervisor. The PO will follow the supervisor hierarchy until it finds a person with the appropriate 

rights to approve the PO. 

 

For workflow checkpoints (excluding supervisor approval), there is a time out period of 5 days.  If the 

approval notification is not acted upon within 5 days, the PO will automatically resubmit one more 

time to the same checkpoint.  If the notification is not acted upon after another 5 days, the PO is 

returned to the buyer via a notification that no manager was found for the PO approval.   

 

The following table lists each checkpoint, dollar thresholds, and current members who can 

approve in each checkpoint: 

 

Responsibility Description Name 

   BENEFITS B Approval Rights for BENEFITS <= $50,000 Lisa Ciletti 

Jack Kennedy 

Chipiwa Zimbwa  

BENEFITS D Approval Rights for BENEFITS <= $250,000 

Approve or Reject BENEFITS > $250,000 and 

< $2M prior to the automatic forward to DIR 

PS Responsibility 

Michelle Piekutowski 

 

REGULATORY  No Final Approval Ellen Conser 

Anthony Noone 

HAZMAT 

CHEMICAL 

No Final Approval Jeffrey Harris 

Andrew Lawson 

 

HAZMAT 

BIOLOGICAL 

No Final Approval Jeffrey Harris 

Andrew Lawson 

 

HAZMAT 

RADIOACTIVE 

No Final Approval Jeffrey Harris 

Andrew Lawson 

 

SEI B Approval Rights for SEI <= $250,000 Bernadette Ledwich 

 



 89 

Responsibility Description Name 

   SEI D Approval Rights for SEI <= $250,000 

Approve or Reject SEI > $250,000 prior to 

the automatic forward to the DIR PS 

Responsibility 

Heidi Magnelia 

 

SPA No Final Approval Elizabeth Callaway 

Teri McCort 

Autumn Slobe 

 

PS No Final Approval Jonathan Mosimann 

  

OSP E  Approval Rights for OSP <= $500,000 Kristen Jackson 

Julie M Fredericks 

 

OSP F  Approval Rights for OSP <=$1,000,000 

Approve or Reject OSP >$1,000,000 and < 

$2M prior to the automatic forward to the 

DIR PS Responsibility 

Kristen Jackson 

Julie M Fredericks 

OSP CONSULTING Approval Rights for OSP Consulting 

<=$50,000 

Approve or Reject OSP Consulting >$50,000 

and < $2M prior to the automatic forward to 

the DIR PS Responsibility  

Kristen Jackson 

Julie M Fredericks 

INTERNATIONAL 

68 B  

Approval Rights for International <= 

$250,000 

Qaisar Choudhary 

Katie Price 

 

INTERNATIONAL 

68 D  

Approval Rights for International < $500K 

Approve or Reject International >= $500K 

prior to the automatic forward to the DIR PS 

Responsibility 

Mark Gambone 

INTERNATIONAL 

70 B  

Approval Rights for International <= 

$250,000 

Katie Price 

INTERNATIONAL 

70 D  

Approval Rights for International < $500K 

Approve or Reject International >= $500K 

prior to the automatic forward to the DIR PS 

Responsibility 

Mark Gambone 

INTERNATIONAL 

72 B  

Approval Rights for International <= 

$250,000 

Matthew Coley 

Katie Price 

 

INTERNATIONAL 

72 D  

Approval Rights for International < $500K 

Approve or Reject International >= $500K 

prior to the automatic forward to the PS DIR 

Responsibility 

Mark Gambone 

 

INTERNATIONAL 

73 B 

Approval Rights for International <= 

$250,000 

Qaisar Choudhary 

Katie Price 
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Responsibility Description Name 

   INTERNATIONAL 

73 D 

Approval Rights for International < $500K 

Approve or Reject International >= $500K 

prior to the automatic forward to the DIR PS 

Responsibility 

Mark Gambone 

INTERNATIONAL 

74 B 

Approval Rights for International <= 

$250,000 

Katie Price 

INTERNATIONAL 

74 D 

Approval Rights for International < $500K 

Approve or Reject International >= $500K 

prior to the automatic forward to the CFO 

RESPONSIBILITY(>= $2M to the CFO and 

Board of Directors) 

Mark Gambone 

INTERNATIONAL 

75 B 

Approval Rights for International <= 

$250,000 

Matthew Coley 

Katie Price 

Chipiwa Zimbwa 

 

INTERNATIONAL 

75 D 

Approval Rights for International < $500K 

Approval or Reject International >= $500K 

prior to the automatic forward to the DIR PS 

Responsibility 

Mark Gambone 

 

INTERNATIONAL 

76 B 

Approval Rights for International <= 

$250,000 

Matt Coley 

Katie Price  

 

INTERNATIONAL 

76 D 

Approval Rights for International < $500K 

Approval or Reject International >= $500K 

prior to the automatic forward to the DIR PS 

Responsibility 

Mark Gambone 

 

INTERNATIONAL 

77 B 

Approval Rights for International 

<=$250,000 

Matthew Coley 

Katie Price 

 

INTERNATIONAL 

77 D 

Approval Rights for International < $500K 

Approval or Reject International >= $500K 

prior to the automatic forward to the DIR PS 

Responsibility 

Mark Gambone 

DIR PS Approval Rights for all POs <$500K. 

Approve or Reject POs prior to automatic 

forward to CONTROLLER Responsibility 

Shawn Facchiano 

CONTROLLER Approval Rights for >=$500K  

Approve or Reject > $2M prior to the 

automatic forward to the CFO 

RESPONSIBILITY (>= $2M to the CFO and 

Board of Directors) 

Carrie Nelson 

CFO Approval Rights for All POs (>= $2M requires 

additional approval from the Board of 

Directors) 

Angela Blanton 
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Responsibility Description Name 

   QRO B Approve PO <= $250,000, which then 

forward to International checkpoint for final 

approval. 

Qaisar Choudhary 

Katie Price 

Maria Georges 

 

QRO D Approval PO < $500K 

Approval or Reject PO >= $500K prior to the 

automatic forward to the International 

Checkpoint for approval, then automatic 

forward to the DIR PS Responsibility 

Mark Gambone 

 


